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Radio Frequency Channel (Crystal Monitor 20-S only)

While collecting data with the Crystal Monitor 20-S the user may change the radio frequency
(RF) channel that the device is using to transmit data.

For most applications the user can leave the software in the default mode where the device will
automatically change channels when interference occurs. The user can manually change
channels by selecting the switch RF channel button from the acquisition toolbar.

ONLINE | & m(%)

Switch RF Channel

Advanced users may wish to manually select an RF channel. This feature will be most useful in
environments where the frequency spectrum is known to be busy. On the patient summary
panel the Advanced RF Panel can be displayed. The Get button will display the current RF
channel. The Set button will reset the RF channel to the channel number currently displayed.

W UnNnmLInNnELC I 5 uUmNMLIMNMELC I
] Start w % Start
ll/ Stop J B Stop

IEF' Channel T\H‘* Channel
I *
Z H th : 5
Sirlias H]j Set Get
4 —_—
eart F ate

ShowiHide Advanced
RF Fanel
Current RF Channel Get'det RF
Channel
Cleveland Medical Devices Inc. 1-877-CleveMed
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Chapter 7: Reviewing Data

Opening Saved Studies

Once a data file has been recorded, it can be reviewed. During the review, it can be scored or
the display settings can be changed, just as during the recording.

To review a previously recorded study:
e
t'..',x‘ﬁ? Review Studies

D Click the Review Studies button on the Main Menu -~

This displays the Open Study... dialog window, where you select the study you wish to review.

5 Dpen Study... ) - 10| x|

Pleaze zelect a study for review from the list provided below,

Fatient| [ I L aztM ame I Firzth ame I StudyM ame i T estD ate l
1 Sample Johin 123 8242035 12:00:00 Ak
1 Sample John 123 5/11/2004 12:00:00 Abd

&9 Add | g Remove |

Test Date  2/2/2035 Physician s

Test Time  12:00:00 &M Tachhician: % @

b"‘.ﬂ

: Cancel |

The top portion of the Open Study... window displays a list of all studies in the system. Studies
can be arranged in order by Patient ID, Last Name, First Name, Study Description or Test
Date by clicking on the appropriate column title. A brief summary of the highlighted study is
found on the lower half of the screen, detailing the date and time of the study, the associated
physician, attending technician, and a brief description of the study.

Cleveland Medical Devices Inc. 1-877-CleveMed
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To open a study for review:

D Select the study you wish to review, then
D Click the OK button on the bottom of the window.

Click the Cancel button to dismiss the window without opening a study.

Adding a Patient Study from a Memory Card

After inserting an SD card in the card reader,
. . . . 1&% Review Studies
Click the Review Studies button on the Main Menu b

¥ Open Study... _-JE.IEI

Fleaze select a study for rexiew from the list provided below.

Fatient| | LastMame | Firsth ame | StudyM ame I TeztDate |
1 Sample John 123 8422035 12:00:00 Ak
1 Sample John 123 5A11/2004 12:00:00 Akd

&P Add | & Femove |

Test Date 8/2/2035 Physician s

Test Time 1200004k Technician =x%

b“#

Cancel |

Click M to open a browsing window

Cleveland Medical Devices Inc.
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Lok jn: | ) Importhd odule j - ek B
G Local Disk [E:) -
|5 DewPSG
=3 Importk odule

i DVD-R&M Drive [F)

age Local Disk, [G:]

“e® Removable Dizk [H:]

g Local Disk (12

B 09PROCDOT ():)

L 2R emovable 3

x documents on 'Engineering Laptop [enarl]
ég CHDI Mail an 'CMDI-Server [M:]

My Dacuments ;:E zhare on 'MeurdW ave_Data [neurowave_
ég FDrive on 'Snap Server [CMDI-Swr]' [F]
'f_-_r ;}g mail on 'cdimage’ [F:]
-l 5% CMDI Sales on 'TMDI-Server (5:)
My Computer x Developrment on 'Engineering Laptap [eng

;:E deploy on "Saftware Test Station [swtest]' [
jg neuromaved on 'ocmdi-zerver’ ]

;E deploy on ‘software-test]' [£:]

u‘ﬂi Logitech CuickCam 'web #3 j Open

(=3 Shared Documents ﬁ e
|5y CFrederick’s Old Docurnents

[ R S R IS o e ]

fit

Select the removable disk that refers to your SD card. The drive name will vary depending on
the computer used and the number drives available.

2]

Look jr: I'h-' Remaovable Disk [K:] j = EF Ex-

My B
Do

File narne: I j Open I
Files of bype: | PSEG File [%psg) | Cancel /l
o
Cleveland Medical Devices Inc. 1-877-CleveMed
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Select the "CLEVEMED" folder

From "Files of type" Select "Mem Card File (*.brx)"

Lack in: || CLEVEMED =] & o5 B3

0001, BR
0002.BRY
=toons, BR:
Dieskto Ju]
hy Diocuments
o
My Computer
l-ﬁ
File hame: |03 BRX | Open |
Files of type: f Mem Card File [*.brx) | Cancel |
P

Select the file you wish to import and Click <Open>

The New Study Wizard will appear and you should follow the steps you normally would to start
a new study (see Proceeding Through the New Study Wizard)
After you click <Finish>, a progress window will appear showing the import process

1.10ME of 259 ME read
EENNRENNER

After the import progress window closes, a new entry will appear in the list of studies.

Cleveland Medical Devices Inc. 1-877-CleveMed
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¥ Open Study... & IEllﬂ
Fleaze select a study for rexiew from the list provided below.
Fatient| | LastMame | Firsth ame | StudyM ame I TeztDate |
] Sample John 123 8/2/2035 12:00:00 Ak
1 Sample Jahn 123 5/11/2004 12:00:00 Ak

John 23 511./2004 1 20000 A

&P Add | & Femove |

Test Date 5/11/2004 Physician s

Test Time 1200004k Technician =x%

b“#

0k | Cancel |

To review the study select the newly added study and click <OK>.

Cleveland Medical Devices Inc.
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Review/Acquisition User Interface

The same user interface is used for both acquisition and review in order to facilitate quick and
simple study collection, review, and scoring. The layout is annotated in the figure below.

Main Menu Main Toolbar

Acquisition
Toolbar

- Score Palette |
File Wiew ols  Help

[fa00 =] sec |fan

3w « » 0 g

Ea] |u J_>| Events I

. Central &pnea
Evens | B tixed_2pnea
Obstructive Apnea
X e A - Central Hypoppnea
| Epoch | E vent | Time | [iation Mived Hypopnea
Q 34 Lights0ut 113122 PM 16.93 zec . ok oy
H= 0.Hypopnes 19:41:50 PM 1290 sec structive Hypaop...
| [ Arousal 11:42.01 PM 5.37 sec . Arousal
| |7 0.Hypoprea 11:42:51 PM 14.00 sec F{[ Cornment
.5? Arousal 11:43:05 P 1.74 sec @ Lights Out
- o Eve nts P anel 207 s gL
7a C.Hypopnea R==3 1.36 sec - Lights On
| [ Arousal 11:56:48 PM 2.02 sec 12 pLm
BB AR | 1740 40 Ahd 170 e

“Score
Palette

EEG1
F————— Comments
EEG2 Grit Teeth
_ Eve Blink
Eve Movement
LEOG b
Adjusting Leads
Tech in Room
REOG Tech leaves Room
Drezaturation
EmG1
EMG2 l: i :r 1 1:1 :1 1: Y :l ul w: 1 :1 "rﬁr i 1'_'7 1:1 I
L T R ; oot A R S SRR T~ ;

The Main Menu bar contains the File, View, Tools, and Help menus. These menus provide a
convenient way of accessing information controlling various aspects of the acquisition module.
The File Menu has the following commands:

(& Open... Ctrl+o | —— Allows opening of files for review *

E Save — P Saves changes to the file (Scores, stages, etc.)
E:xport —pCalls the Export wizard, which allows export
_ of data to ASCII and EDF formats *
Exit —— P Closes the program

*Note: opening of files for review is not available during acquisition

The View Menu has the following commands that allow you to configure the display of
the application.

Cleveland Medical Devices Inc. 1-877-CleveMed
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£/ Acquisition Panel —»Toggles Show/Hide of Acquisition Panel
:% Events ——®»Toggles Show/Hide of Events Panel
% Wigw Hypnogram ——— > Toggles Show/Hide of Hypnogram Panel
E@ Score Palette  ———PToggles Show/Hide of Score Palette
Stage Bar — P Toggles Show/Hide of Stage Bar (Obsolete)
|T Clip Channels ~ ————pToggles Clipping of channels
|T Show Stage ] Toggles Showing of sleep stage on page background
|T Shove AutoScores————— P Toggles Show/Hide of Hypnogram Panel

The Tools Menu has the following commands:

'QE; Edit Monkage —— P Opens the Montage Editor
Save Montage —— P Saves alterations to the current montage

Re-scan File (Score)  —T—® Starts automatic scoring of the data file*
video Module —— > Starts the video module viewer

Options ——POpens the system configuration window

*Note: automatic scoring is a review function not available during acquisition

The Help Menu provides access to an online manual and contains software version information.

Cleveland Medical Devices Inc. 1-877-CleveMed
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Main Toolbar

The main toolbar in Crystal PSG provides quick and convenient access to the major functions of
the system, some of which were outlined above.

Timescale Current Edit Navigation Layout Waveform
Montage Montage Controls Controls Controls
200 =] sec ||a T AW | E || kAT
I
Live/Review
Mode Toggle

Main Controls

Timescale: Allows the user to change the page size
of the display graph; the traces should
expand with decreasing time and
compress with increasing time.

Current Montage: Allows the user to select a different
layout setting. The layout dictates how
and what array of waveforms to display.

Allows the user to add, edit or remove

e Edit Montage: X : :
waveform display configurations.

Toggles live updating of the review
display. When “Locked” the navigation
buttons are disabled, and the screen will
be updated once a second with the
newly acquired data.

éLive/ Review Mode Toggle:

Navigation Controls

Moves the display to the beginning of

M .
Begin the data file.

Keyboard shortcut: <Home>

Moves to display back one page (page

" .
Previous Page
I size dictated by the Timescale setting).

Keyboard shortcut <PgUp>

" Next Page (poge. size diated by the Timescel
Keyboard shortcut <PgDn> pag y
setting).
M End Moves the display to the end of the data
Keyboard shortcut <End> file.
Cleveland Medical Devices Inc. 1-877-CleveMed
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Layout Controls

*/_"{ Acquisition Panel

Toggles Show/Hide of Acquisition Panel

(1

Events Panel

Toggles Show/Hide of Events Panel

#h Hypnogram Panel

Toggles Show/Hide of Hypnogram
Panel

i Score Palette

Toggles Show/Hide of Score Palette

Waveform Controls

h

™ Scoring:

Allows the user to highlight and label
specific portions of the display.

57
& Measure:

Allows the user to magnify a small
portion of the graph and obtain
statistical data/measurement
information from that portion.

Cleveland Medical Devices Inc.

1-877-CleveMed
40



)

il

,......
(D
<<,
@
S
0

Crystal Monitor PSG Series User’s Guide

oy

(
¢

Acquisition Toolbar

The acquisition toolbar provides control over system data acquisition as well as status
information.

Online/Offline  Start/Stop ) ) Body
Indicator  Acquisition Recording/System Time ~ SpO2  Heart Rate pqition

oniine | o u | TR W N

Offline/Online indicator Shows the state of the Crystal Monitor
transmitter (whether it is on or off or out
of range).

Start/Stop Acquisition Controls start and stop of acquisition

Recording/System Time Clicking this label toggles between
showing time of day or elapsed
recording time.

SpO2 Heart Rate and Body Real-time indicators of live acquisition

Position data

Keyboard Shortcuts

Select Next Trace (Above): <Up Arrow>

Select Next Trace (Below): <Down Arrow>

Increase Trace Gain: <Shift> + <Up Arrow>
Decrease Trace Gain: <Shift> + <Down Arrow>
Move Trace Up (offset): <Ctrl> + <Up Arrow>

Move Trace Down (offset): <Ctrl> + <Down Arrow>
Beginning of Recording: <Home>

End of Recording: <End>

Page Forward: <Page Down>

Page Back: <Page Up>

Scroll through the study: <Right Arrow> or <Left Arrow>
Speed of Scrolling: <Right Arrow> or <Left Arrow>
Increase Event Length: <Shift> + Left Mouse
Decrease Event Length: <Shift> + Right Mouse

Cleveland Medical Devices Inc. 1-877-CleveMed
41



Crystal Monitor PSG Series User’s Guide f

Adjusting Individual Signals
To make changes to each signal double left click on the name of the channel you would like to

adjust. A new window will open.

{8 Editing FEG1

Color — Can change Mame: |EEG1 ak.

display color of individual
channels coor. |
Cancel

Range Offzet High-cut
Range - Increase  ——1a0000 < 0000 =, [0 -

value to decrease

signal amplitude Loww-cut

Lowwer T
[95.000 = 05He x|

Offset —adjusts the_—~ " I =1 Notch Fier
position of the
signal (O] =

1-877-CleveMed
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Staging Guide
) At any time during review, the user may stage the
0: Wake . .
1: Stage 1 current page by using the numeric keypad, or
) numeric keys according to the following
2: Stage2 definitions:
3: Stage 3 '
4: Stage 4 . . .
For convenience, the system is set to automatically
5: REM .
page forward to the next epoch (30sec), each time
6: Movement

a new stage is entered.

As part of the review window, a hypnogram view
is provided that will show a 20 minute window of the sleep architecture. The value of the
current epoch is shown according to the y-axis of this plot and a highlighting bar indicates the
position of the current page within the plot.

I el b= [
Sleep Stage Position /

Plot indicator

Scoring Guide

To begin scoring, you must first open the Score Palette window. To do this, open the View
option at the top of the screen and select Score Palette. You may need to expand your screen
window to view the entire page.

Scare Palette |

£ Acquisition Panel

= Events |
= Events

. Central &pnea

o
= View Hypnograrnm Mixed_Aphea

E@ Score Paletke g Toggles Show/Hide of Score Palette Obstructive Apnea
Stage Bar Central Hypopnea
Mined Hypopnea
|7 Clip Channels . Obstuctive Hepop...
|7 Shiow Stage ..fl'-.rnusal
|7 Show AutoScores 1= Comment
& Lights Out
&' Lights On
12 PLM
After opening the Score Palette, select the Scoring ® button. This o |%1DsAT ou to

mark and label any section of the chart. Once the Scoring button has been selected, you may
choose any event on the right side of the screen.

Cleveland Medical Devices Inc. 1-877-CleveMed
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Marking Events

The colored boxes show events commonly seen in patients being
assessed for sleep disorders. If a particular color is selected, the color
and label will appear on any section you choose. To mark (or score) a
certain area, highlight the area with your left mouse cursor and drag it
over the length of the event. For faster scoring of repeated events, just click the same channel
again without dragging.

%

A default event can be set for each

i e TS5 [@ 4 4w v B2 s @a] ]l channel. Place an event on a channel.
EEGT W Nbmbisnahpmf et ptibadent i mmssaminstieosd | \With the event selected right mouse
G2 N A e click and select Set as Default from the
(0B e ; ' ] MENU.

== Al s The duration of events can be adjusted

EMG1

by holding the shift key and using the
right and left mouse buttons. The left
mouse button will lengthen the
duration and the right mouse button
will shorten the duration.

EME2

ECG

(15.70mYy)

ThoE
Delete

BBIE TN\ Froperties

SPO2
95 g¢ 53 95 9 oy 95 94 o3 35 % g4
S2 8 g %2 a0 3 g 2 g0 @

90 89 83 e 8 g e 88
BODY

> PP P P B P P PP PP P.P PP P PP P F P P PP P P P.P P F

SNORE

ﬂns:m 02:10:60 404 021107 At 02:11:24 204 02:11:42 At 02:11:69 04 02:12:16 A
l

Jol

Auto-Scoring

B Crystal PSG

TR T TEET Previously recorded studies can be
BroCitesoen ey wimmmmigasaisieons|  aUtoscored by selecting Tools and Re-
== e scan file (autoscore). Auto-scoring will
e | . ‘ . score events such as arousals, apneas,

o hypopneas and desaturations. Auto
\|' e "" d Y " iy e staging is not available in Crystal PSG.
WWWW' Auto-scoring a file will not delete any
Ec manually entered scores. On the events
= m list auto-scores will be marked so
.y L,w\,-,. manual and auto-scores can be easily

AbdE N i W P R W W I g T 1 A Y differentiated-

R N ) SO ey - Ry S SO i ey W
IR A R T BT ¥y

90 89 g3 e 89 57 @ 89

EMG2

BODY

>PPPPHPFPPPPFPPFPPPFPPFPPPHPFPFPPPFPPFPFPEF

SNORE

Hmam 02:10:50 24 021107 At 02:11:24 204 02:11:4 At 02:11:59 204 02:12:18
<

Il
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Adding Comments and Bio-cals Comments
To add a comment to a certain area, select the Comment [l button. E'“ TBTEE"
ye Blin

Then, in the bottom window, you can select a specific pre-labeled |, mavement
comment (such as Leg Movement or Eye Blink). If desired, you may |Adiusting Leads
enter your own comment in the space provided. If you click the Add EEE :Qaﬁﬂezrgmm
button, it will be permanently added to the comments box for future |Desaturation use.
If you do not click Add, then it will be used once. To remove a saved
comment, highlight it in the list and click Remove.

To put the comment in a certain area on the trace, choose a
comment, then, highlight the area with the cursor.

Add | Remove

Cleveland Medical Devices Inc. 1-877-CleveMed
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Measuring Tool

To obtain more detailed information about the waveforms, choose the Measuring % Tool.
Then highlight the desired section of the graph. A new window will appear in the middle of the
screen with an enlarged view of the highlighted section and statistical data on the left side of
the new screen.

i+ Review Session: [Dae, John - cpAP] =10l x|

File Wiew Tools

[[500 =] sec[Fecodeal =] Q5 [ @ | W « » w2k Qlax

Review | Score Pelts |
—. —— — Events
B Central Aprea
EEGZ | *ownienm & B Mived_Apnea
Obstiuctive Apnea
EEGT i e Central Hypopnea
Mixed Hypoprea
Birflow S VI S Y S ST . Obstructive Hypopnea
W 2ousal
- I Measure: EOG . | | [IZl Comment
Trace: EOG
Duration: 3.415 see 3 Lights O
BEffort | """ amplitude: 0.492 | | Lights On
Max: 0.156
TEffort s 0335
EMG
Pleth EE N K] 03
Comments
HR2 20 7D TBD L2y T T T gy T B90 BT B50 6l 6.0 l—
Sal2 £00 0 80 980 8E0 980 080 SED 030 S0 080 930 880 030 Teg Morvemert
Eye Blink.
Bodyx [z 02 0.2 0.1 01 0.1 0z 0.1 0z [} 0z 0.2 0z 01 Laose Electrode
Tech in room
Tech leaves room
Bodyt [ AR ) 01 0 00 00 00 00 O ol 0 oo oo Patient out of bad
Patignt back in bed
Batt 07 27 2.7 27 27 27 27 27 27 23 27 2.7 27 27 test
BodvPos {0 B ] § § $ B ] E § B ] B 5
0001:05.510 00:01:11.020 00:01:16 530 0001:22 040 000127 55
3

Measure: EOG k|

Trace: EOG

Duration: 2415 see %
Amplitude: L4932
Max: 0156

Min: -0. 335

The statistical data shows the following:

¢ Trace: which specific channel the highlighted section is taken from
e Duration: the duration of the highlighted section
e Amplitude: the maximum peak-to-peak amplitude of the highlighted section
e Max: the maximum value in the highlighted section
e Min: the minimum value in the highlighted section
Cleveland Medical Devices Inc. 1-877-CleveMed
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The Montage Editor

Click the Montage Editor S button. A new window should appear.

{8 pisplay Manager L i ] 4

Drigplay Configuration

|M:I" Mew | Save | Copy |

Mame Colar |Input |F|ange |E|ffset |Units |High-Eut |L0w-Cut |N0tc:h | ﬂ
B EEGT 190000 0000 W 3500Hz  Q30Hz  (Of) 4dd

EEGZ B EEG: 190000 0000 W 3500Hz  030Hz  (Of)
|LEoG B LE0G 1900000 0000 WY 3500Hz  0.30Hz (O Bemove |
' |REOG B FEOG 190000 14461 W 3500Hz  030Hz  (OH)
|EMGT Gt 190000 0000 W 7O000Hz  QOSHz  (OH)
|EMG2 G2 190000 0000 W 7O000Hz  QOSHz  (OH)
|ECE I ccG 00000 0000w (OH) 005Hz (0K
| PRES B rEs 0800 0000 w¥  200Hz  O0SHz (O
| TheE B TheE 4000 0000w (OF) (0ff) (0t
| ahdF I A 4.0nn n.onn i (Wi} [T1EF) (i} ;I

ak. | Cancel | Help |

This screen enables you to add/remove channels, change the color of certain channels on the
acquisition screen, change the limits of the input, and add low/high pass filters.

The Name box allows you to name the channel. You may edit/change this name as
you see fit.

The Color box changes the color of that channel’s trace when it appears in the
waveform view.

The Input box represents the actual channel from the transmitting device that you
would like to record under this name. These channels are marked appropriately on
the device.

The Range and Offset boxes allow you to set the upper and lower limits on the trace.
The range is equivalent to sensitivity settings on other machines. To enlarge the
graph, set smaller limits. To compress the graph, set larger limits.

The Units box allows you to set the value of one unit.

The Low Pass, High Pass, and Notch boxes allow you to filter the input.

If you would like to make a personalized display configuration, you can click New. You will be
asked to enter a Display Configuration name. After you enter a name, click OK. A blank
display configuration window will appear.

Cleveland Medical Devices, Inc. 1-877-CleveMed
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'E Display Manager i = |EI|5|

Dizplay Configuration
ITest j |ﬂew| Save | Copy |
Mame Calor |Input |Hange |foset |Unit$ |High-Cut |LDw-Cut |Notc:h |
- EEG1 7R0.000 0.00o U (D) [0 [0 Add

d

Bemove

0K | Cancel | Help |

To add a new recording channel, click Add. A new channel will appear. You can manipulate
the settings according to preference. Notice the blue highlighting around the right end of
the channel toolbar. This indicates the channel you are currently modifying. To remove a
specific channel click on that channel, highlight it, and click the Remove button. After you
have completed your personalized display configuration, click the Save button.

To modify an existing configuration without overwriting the original, you may use the Copy
button. Choose an existing configuration, then click the Copy button. You will be asked to
enter a Display Configuration name. Enter a unique name and click OK. You will be able to
modify existing parameters, delete or add channels, and rename existing channels. Once you
have finished, click the Save button. All of the new modifications will be saved under the
new name.

To exit this screen, press OK.

Cleveland Medical Devices, Inc. 1-877-CleveMed
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Chapter 8: Report Generation
To generate a report, from the Main Menu select
Select & open a study according to the same process used for scoring.
Ageilable Repoit Jemplates ) Select a template from the list in order to generate a report
WEST FULL.1f according to a standard format. The report may take up to a

WEST SPLIT_MIGHT.RTF

few minutes to generate depending on the length of the study
and the number of events marked.

Crystal PSG is preconfigured with a few report templates that
your lab can customize. CleveMed is also able to assist you in
creating your own personalized report templates.

Editing and Creating a Report Template

After generating a report, select the view menu to toggle
between “Edit Report” and “Edit Template”. In edit report

=4 Sample. rtf

Az el Iz s e ol mode, the generated report for a particular patient may be
[ = | * EditReport edited. This is used for entering physician notes or scores
: Edit Template for tests that are not part of the PSG test. In edit template
T Al 10 - mode, new templates can be created and edited.
- 3
I
In edit template mode, a list of
D 83 = calculated and drop in merge fields
e v — ] is shown on the right side of the
o [ screen.  Text can be written
e S B o including merge fields when the
T ——— fetee report is viewed in report mode the
S merge fields will be completed with
P S S coon e the data for the selected patient.
il Please contact CleveMed for further
(s Tt NRISES s assistance with creating custom
s report templates.
Ligison " o CREM Shpbisnt.
Chapter 9: Data Storage
e e The default software settings store

patient data files in C:\CleveMed\CrystalPSG. Each recorded study creates two files a header
file (*.psg) and a data file (*.psd). The header and data files are both named by the date and

Cleveland Medical Devices, Inc. 1-877-CleveMed
49



)

,......
(D
<<,
@
S
(D

Crystal Monitor PSG Series User’s Guide

oy

(

time that the file was collected. For example, the files 2005-05-18-23-45-25.psg and 2005-05-
18-23-45-25.psd were created for a study recorded on May 18 2005 starting at 11:45:25 PM. It
is important to not open and edit these files as they may become corrupt or the patient
data may be displayed incorrectly leading to a misdiagnosis.

Note: There is no patient demographic information available in either file. The patient name,
ID and other personal information is not included to comply with HIPAA (Health Insurance
Portability and Accountability Act) in the event of sharing data with other labs or CleveMed.

Before archiving data, it is suggested that a log including the patient ID number, name, study
date, and study time is created. A spreadsheet program, such as Microsoft Excel, could be
used to make the log. To make data retrieval easier, create a folder named for each patient
and copy the appropriate .psg and .psd files into the folder. Then the folder can be archived.

Cleveland Medical Devices, Inc. 1-877-CleveMed
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Chapter 10: Troubleshooting
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If your Crystal Monitor is not performing properly, use this troubleshooting chart for quick

solutions to common problems.

Customer Support at 1-877-CLEVEMED.

If the problem persists, call Cleveland Medical Devices

Symptom: Possible Cause: Solution:
1. No data is being a. Receiver unplugged from PC a. Re-connect to USB port.
displayed

b. Patient Unit power switch off

b. Turn power back on (Patient
Unit)

c. Patient Unit batteries are
exhausted

c. Replace batteries

2. Signal image breaking
up periodically

Dropped packets (poor wireless
signal)

a. Position Computer Unit and
Patient Unit closer together.
Recommended distance is 100
feet (20-S) or 50 feet (20-B) direct
(line of sight)

b. Move large metal objects away
from the area.

c. Contact CleveMed for
instructions on performing a
frequency spectrum survey to
determine good recording
channels for your environment.

3. Signal image cut off

Amplitude of data exceeding
visible range

Adjust scale control

4. Signals difficult to
visualize

Channel color selected does not
contrast well with screen
background chosen

Change channel color

5. Signals are noisy

a. Electrode impedance is too high
or miss matched

a. Check the impedance on the
patient electrodes and replace
electrodes with high impedance

b. Display settings are not correct

b. Adjust the filter settings on
the channels that are noisy

c. System failure

c. Please contact customer
support for further assistance.

6. Computer freezes up
or display appears
choppy

a. PC needs a faster processor

a. Run Crystal Monitor PSG on a
Pentium [lI™ 500 MHz or higher
system.

b. Timescale is too large to display
the requested number of data
points

b. Change the timescale to a
smaller value.

7. No receiver found

a. No power to the receiver

a. Check that the USB cable is
not damaged, is properly
connected to the Computer Unit

Cleveland Medical Devices, Inc.
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and to the computer

b. Drivers are not installed

b. See Chapter 3 Setting up the
System.

Cleveland Medical Devices, Inc.
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